Direct Drive Turntable
- AT-LP5 with Analog and USB Outputs -

Platine tourne-disque à entraînement direct
AT-LP5 sorties RCA analogiques et USB

Giradisco de tracción directa
AT-LP5 con salidas RCA estéreo analogico y USB

Installation and Operation Pages 2-7
Installation et utilisation Pages 8-13
Instalación y funcionamiento Páginas 14-19
Direct Drive Turntable with Analog and USB Outputs

Safety instructions

1. Read these instructions.
2. Keep these instructions.
3. Follow all instructions.
4. Follow all instructions.
5. Do not use this apparatus near water.
6. Clean only with a dry cloth.
7. Do not block any of the ventilation openings. Install in accordance with the manufacturer’s instructions.
8. Do not install near any heat sources such as radiators, heat registers, stoves, or other apparatus (including amplifiers) that produce heat.
9. Do not defeat the safety purpose of the polarized or grounding plug. A polarized plug has two blades with one wider than the other. A grounding plug has two blades and a third grounding prong. The wide blade or the third prong is provided for your safety. If the provided plug does not fit into your outlet, consult an electrician for replacement of the obsolete outlet.
10. Protect the power cord from being walked on or pinched particularly at plugs, convenience receptacles, and the point where they exit from the apparatus.
11. Only use attachments/accessories specified by the manufacturer.
12. Use only with a cart, stand, tripod, bracket or table specified by the manufacturer, or sold with the apparatus. When a cart is used, use caution when moving the cart/apparatus combination to avoid injury from tip-over.
13. Unplug this apparatus during lightning storms or when unused for long periods of time.
14. Refer all servicing to qualified service personnel. Servicing is required when the apparatus has been damaged in any way, such as power-supply cord or plug is damaged, liquid has been spilled or objects have fallen into the apparatus, the apparatus has been exposed to rain or moisture, does not operate normally, or has been dropped.
15. Where a mains plug is used as the disconnect device, the disconnect device shall remain readily operable.
16. Please keep the unit in a good ventilation environment.
17. Apparatus shall not be exposed to dripping or splashing and no objects filled with liquids, such as vases, shall be placed on apparatus.

Warning: To reduce the risk of fire or electric shock, do not expose this apparatus to rain or moisture. The apparatus shall not be exposed to dripping or splashing and that no objects filled with liquids, such as vases, shall be placed on the apparatus.

Caution: To reduce the risk of fire or electric shock, do not expose this apparatus to rain or moisture. The apparatus shall not be exposed to dripping or splashing, and no objects filled with liquids, such as vases, shall be placed on the apparatus.

The lightning flash with arrowhead symbol within the equilateral triangle is intended to alert the user to the presence of uninsulated “dangerous voltage” within the product’s enclosure that may be of sufficient magnitude to constitute a risk of electric shock.

The exclamation point within the equilateral triangle is intended to alert the user to the presence of important operation and maintenance (servicing) instructions in the literature accompanying this appliance.

Caution: To prevent electric shock, do not use this polarized plug with an extension cord, receptacle or other outlet unless the blades can be fully inserted to prevent blade exposure.

FCC Notice

Warning
This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

Caution
You are cautioned that any changes or modifications not expressly approved in this manual could void your authority to operate this equipment.

Note: This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:
— Reorient or relocate the receiving antenna.
— Increase the separation between the equipment and receiver.
— Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
— Consult the dealer or an experienced radio/TV technician for help.

IC statement:
CAN ICES-3 (B)/NMB-3(B)
Introduction
Thank you for purchasing this AT-LP5 Direct Drive Analog and USB Turntable. Audio-Technica brings its legendary quality and audio fidelity to the authentic home-use turntable. In the box, you’ll find everything you need to transfer your classic LP collection to digital files:
Audio-Technica’s AT-LPS stereo turntable, complete with USB output that allows direct connection to your computer; Audacity recording software for Mac or PC; USB cable and an RCA / RCA stereo adapter cable. This turntable also includes an integral dual-magnet Audio-Technica exclusive AT95EX cartridge, sophisticated J-shaped tonearm, and offers a built-in switchable phono/line pre-amplifier that provides connection to a stereo system equipped with either phono or line-level inputs.
The AT-LPS Direct Drive Turntable has the following features:
• Audio-Technica AT95EX Dual Moving Magnet stereo cartridge with replaceable stylus
• Exclusive Audio-Technica AT-HS10 Lightweight Headshell
• Cast aluminium record platter with rubber mat
• Selectable internal stereo phono pre-amplifier
• Stereo RCA analog outputs

Main Features
• J-shaped tonearm assembly with:
  • Adjustable counterweight
  • Anti-skate adjustment
  • Tonearm lift with hydraulic action and lift lever
  • Tonearm rest with locking mechanism
• USB output—no special drivers required for direct connection to your computer
• Direct drive high-torque motor
• Selectable 33/45 RPM speeds
• Adjustable feet for leveling
• Hinge mounting points with screws for optional removable hinged dust cover

To assure maximum satisfaction from this product, please read the information and follow the instructions presented in this manual. Please keep the manual in an accessible location for future reference. We suggest that you save all packaging materials for possible future storage, moving, or shipping.

Caution: To avoid stylus damage, make certain the included stylus guard is in place whenever the turntable is being installed, moved, or cleaned.

Figure 1

1. 33 / STOP / 45 STANDBY AND SPEED SELECTOR KNOB
   Selects 33 or 45 RPM platter speed and starts/stops the motor.
2. PLATTER
   Cast aluminium platter mounts directly to center spindle/motor shaft.
3. CENTER SPINDLE
   Precision-machined platter mount on motor shaft.
4. DUST COVER HINGE HOLERS
   Attachment points for removable hinged dust cover.
5. TONEARM ASSEMBLY
   Refer to Figure 2 on page 4 for details.
6. ON/OFF INDICATOR LIGHT
7. RUBBER MAT
Tonearm Assembly Diagram

Figure 2

8. HEADSHELL and CARTRIDGE
   Exclusively high performance AT95EX cartridge is mounted with headshell.
   AT-HS10 light weight headshell suits perfectly with J-shaped tonearm.

9. HEADSHELL LOCKING RING
   Rotate counter-clockwise (to the left) to draw the inserted headshell firmly into its seated, locked position. Rotate the ring a full turn to the right to permit removal of the headshell.

10. TONEARM
    J-shaped tonearm geometry reduces tracking error.

11. TONEARM LIFT
    Elevates tonearm above record surface.

12. TONEARM REST WITH LOCKING CLAMP
    Locking clamp secures tonearm during transport.

13. TONEARM LIFT ADJUST SCREW
    Used to set the amount of tonearm lift.

14. TONEARM LIFT CONTROL LEVER
    Controls action of tonearm lift. (Note: Lift mechanism is hydraulically damped to slow tonearm descent.)

15. ANTI-SKATE CONTROL
    Applies a small outward force to the tonearm, counteracting the tendency of the tonearm to move inward toward the center of the record when the record rotates.

16. COUNTERWEIGHT
    Balances the tonearm and provides adjustment for proper downward tracking force on the stylus.

Rear View Diagram

Figure 3

17. RCA STEREO ANALOG OUTPUT
    Use these terminals to connect the RCA stereo cable with attached grounding to the phono input terminals or line input of your amplifier.

18. PRE-AmPLIFIER SELECTOR SWITCH
    Allows the internal stereo phono pre-amplifier to be bypassed when the turntable is used with amplifiers having magnetic phono inputs.

19. GROUND TERMINAL
    Use this terminal to connect the grounding line of the RCA cables to the ground terminal of the amplifier.

20. USB OUTPUT
    Use this output to connect your turntable to the USB input of your computer.

21. AC INLET
    To connect the power cord supplied with the unit.

22. ON/OFF SWITCH
    Use this switch to switch on / off power to the turntable.

23. ADJUSTABLE FEET FOR LEVELING
    Rotate feet to adjust leveling.
Unpacking
Carefully unpack the turntable and verify that the following parts are included and intact:
- Rubber mat
- Dust cover (above the turntable)
- Platter (under the turntable)
- Counterweight (accessory section)
- AT-HS10 headshell with pre-mounted AT95EX Dual Moving Magnet stereo cartridge (accessory section)
- Exclusive AT-HS10 Lightweight Headshell
- Power cable
- USB cable
- Dual RCA male to dual RCA male cable with grounding line
- Audacity software (CD)

WE RECOMMEND THAT YOU SAVE ALL PACKAGING MATERIALS FOR POSSIBLE FUTURE STORAGE, MOVING OR SHIPPING.

Assembling the Turntable
The AT-LP5 requires some assembly before first use.
IMPORTANT: Do not connect the AC power cable until assembly is complete.

Setting the Pre-amplifier Selector Switch
For increased flexibility of use, this turntable has an internal stereo phono pre-amplifier. The pre-amplifier selector switch located in the rear panel of the turntable (See Figure 3, page 4, #18), selects the internal stereo pre-amplifier (LINE), or bypasses the pre-amplifier (PHONO OUT) for use with systems having specialized magnetic phono input sockets. The audio output cable’s Red RCA-type plug is the Right channel; the White plug is the Left channel.

If the system you are using has a phono input, set the pre-amplifier selector switch to the PHONO position and connect the turntable’s output cables to the phono inputs on your system, observing Red for Right channel and White for Left channel, in addition connect the grounding line attached to the stereo RCA / RCA cables to the ground terminals.

If your system does not have a magnetic phono input, set the pre-amplifier selector switch to LINE and connect the turntable’s output to the Auxiliary (AUX) or other high-level inputs on your system, observing Red for Right channel and White for Left channel.

When using the turntable with a computer sound card, set the switch to LINE and connect the turntable’s stereo output to the audio line input on the computer sound card. Note: An audio adapter (not included) may be required to interface the two RCA outputs (L + R) of the turntable to the computer sound card input.

Assembling the Tonearm
1. Remove the nylon tie used to secure the tonearm during shipment. Temporarily secure the tonearm in the tonearm rest with the locking clamp. [Figure 2, page 4, #12].

2. Attach the headshell/cartridge assembly by inserting it into the socket at the front of the tonearm. [See Figure 4]. It is good practice to hold the headshell assembly by the left and right edges of the headshell to reduce the possibility of damaging the stylus or disrupting the cartridge wiring.

3. While holding the headshell in position, rotate the headshell locking ring counter-clockwise (to the left). As the ring turns, it pulls the headshell into its seated position (rotate the ring a full turn to the right to permit removal of the headshell).

4. With the black dial toward the front, use a screwing motion to attach the counterweight to the arm extending back from the tonearm pivot [Figure 2, page 4, #16]; the counterweight will engage the spiral groove in the rear arm section and move forward.

Assembling the Turntable Platter and Rubber Mat
1. Carefully place the turntable platter on the center spindle, making certain the platter is fully seated on the spindle.
2. Place the rubber mat on top of the platter.

Setting Tonearm Balance and Tracking Force
To ensure the cartridge tracks properly in a record, the tonearm balance and tracking force must be carefully set to the cartridge manufacturer’s specifications. Failure to properly set up the tonearm assembly can cause damage to the cartridge stylus and/or records.

Note: Once the stylus protective cover has been removed and the tonearm locking clamp has been released, take extreme care not to damage the stylus. Do not allow it to drag or scrape across the rubber mat nor the record.

Tonearm Setup
1. Set the anti-skate adjustment to “0”. [Figure 2, page 4, #15].

2. Remove the clear protective stylus cover, carefully sliding it straight forward, off the front of the cartridge.

3. Continuing to gently hold the headshell to stabilize the tonearm, release the tonearm locking clamp. At this point, the tonearm is unbalanced and free to swing.

4. Continuing to gently hold the headshell, carefully rotate the counterweight until the tonearm is horizontally balanced and hovers freely just above the platter without touching the cartridge on the platter surface.

5. Lock the tonearm back into the tonearm rest.

6. While holding the counterweight steady, and without any rotation, carefully rotate only the black stylus force gauge ring (which turns independently of the counterweight) until the “0” on the gauge ring lines up with the centerline marked on the rear arm. Refer to the specifications section for tracking force value for the cartridge that shipped with the turntable, typically 2 g for the AT95EX.

7. Refer to the cartridge manufacturer’s specifications for recommended tracking force. Rotate the entire counter-weight counterclockwise without touching the black gauge ring, moving the counterweight forward, until the desired value on gauge ring lines up with the centerline marked on the rear arm. Refer to the specifications section for tracking force value for the cartridge that shipped with the turntable.

Setting Anti-skate
A small outward “anti-skating” force can be applied to the tonearm to compensate for the “skating” force that pulls the arm toward the center of the record when rotating. For best performance during normal turntable use, set the anti-skate control knob [Figure 2, page 4, #15] to the same setting as the tracking force dial. Refer to the specifications section for tracking force value of the cartridge that shipped with the turntable.

Figure 4 – Headshell with fitted cartridge
Initial Setup (continued)

Assembling the Dust Cover

1. Insert the T-shaped ends of the dust cover hinges into the two hinge receptacles located at the back of the turntable housing. When properly installed, the flat part of the cover hinges should be facing away from the turntable housing at about a 45° angle.

2. Holding the dust cover over the turntable, carefully guide the cover hinges into the two slots molded into the rear of the dust cover. The springs in the hinges allow the cover to be held open at about a 45° angle if desired. (Note: There is only one "open" position; the hinges do NOT permit the cover to stand "straight up.""

3. To remove the dust cover from the turntable, gently disengage the hinges from the slots in the cover. This is usually easier when the cover is in the "closed" position. Slowly and carefully lift straight up until the cover is clear of the unit. The hinges may then be removed from the turntable base, if desired.

Analog Audio Connections

Connect the audio output cable to the appropriate input sockets on your amplifier, receiver, powered speakers, soundcard or other device based on the setting of the pre-amplifier selector switch.

Digital Audio USB Connection to Computers with USB Input

The USB cable (included) connects your AT-LP5 turntable to your computer without need for special drivers.

Your Audio-Technica AT-LP5 turntable is supplied with Audacity recording software for your convenience. Please note that other third-party software packages are also compatible with this turntable.

Audacity

Audacity is free software, distributed under the GNU General Public License (GPL). More information and open source code is on the included Audacity CD and on the Audacity website: http://audacity.sourceforge.net

* When using USB output always set the AT-LP5 turntable’s Pre-amplifier Selector Switch to the “LINE” position (switch is located on the back of the turntable).

Finally, after all audio connections are made, attach the included AC power cord to the turntable. Then connect the power cord’s plug to a convenient AC outlet.

For best results, do not install or operate this unit near conditions of heat, moisture, dust, or heavy vibrations.

Preparing to Play

1. Remove the stylus guard from the stylus assembly and unlock the tonearm rest if it is locked.

2. Place a record on the rubber mat, lining up its center hole with the center spindle. For 45 RPM records, place the 45 RPM adapter on the center spindle before placing the record on the platter.

Playing a Record

1. Press the power button on the rear panel to switch on.

2. Set the platter rotation speed (33/45) to match that of the record, the platter begins to rotate.

3. Raise the tonearm by lifting the tonearm lift control lever to the UP position.

4. Position the tonearm over the desired location (groove) on the record.

5. Lower the tonearm by moving the tonearm lift control lever to the DOWN position. The tonearm descends slowly onto the record and play begins.

-- or -- (skipping 2 - 3 - 4)

Use the finger-lift on the headshell assembly to position the tonearm over the desired location on the record. Carefully lower the tonearm to the record surface.

Suspending or Ending Play

1. To suspend play, lift the tonearm with the tonearm lift control lever.

2. When play is finished, raise the tonearm lift control lever, move the tonearm to the rest position and secure the tonearm with the tonearm locking clamp.

3. Turn the speed selector to “Stop” to apply the brake and stop the platter rotation.

4. Press the power button on the rear panel to switch off.

Installing a new Cartridge

Mechanical Assembly

1. Unpack the cartridge and carefully remove its stylus assembly. Place the stylus assembly out of harm’s way. Mount the new cartridge to the headshell assembly. Use the mounting hardware supplied with the new cartridge. Tighten the mounting screws until just snug. Replace the stylus assembly briefly to check for mechanical interference with the mounting hardware. The stylus assembly should click into place. Make certain the new cartridge is properly positioned in the headshell assembly per the manufacturer’s instructions. Again remove the stylus assembly for safekeeping.

Electrical Connections

1. Four terminals at the rear of the cartridge are color coded to match standard wiring in stereo turntables. Connect the cartridge with the slip-on lugs provided on the headshell wiring. NEVER SOLDER TO CARTRIDGE TERMINALS! Heat applied to the terminals will damage the internal cartridge wiring.

2. Finally, gently push the stylus onto the cartridge body being careful not to damage the stylus. The stylus assembly should click into place. Replace the headshell assembly onto the tonearm taking care not to damage the stylus assembly.

(Note: After replacing the cartridge, reset the tonearm balance, stylus force and anti-skate based on the cartridge’s specifications.)

Using a MC (moving coil cartridge)

1. Note that the built-in phono pre-amplifier has a 36 dB gain with an input impedance of 47k ohms and is intended to be used exclusively with moving magnet cartridges such as the supplied AT95EX. When using a moving coil cartridge it is essential to bypass the built-in pre-amplifier section switch (Figure 3, page 4, #18) by setting to the phono position. In this case the turntable stereo phono output needs to be connected to an external phono pre-amplifier featuring MC (moving coil) inputs, in order to guarantee the proper gain and the proper impedance load necessary when using an MC cartridge (refer to the specifications of your MC cartridge).
Troubleshooting

Turntable operates but emits no sound or not enough sound.
1. Amplifier (system) controls are set incorrectly: wrong input selected, tape monitor on, speakers switched off, etc. Verify proper control settings.
2. Stylus is broken or missing. Check the stylus assembly and replace if necessary.
3. The stylus assembly may not be fully seated in the cartridge body. Check the cartridge and adjust if necessary.
4. The pre-amplifier selector switch of the AT-LPS is set in the wrong position. Verify that it is set to the correct output to match amplifier input.
   - No sound/very weak sound: Phono Out setting into an Aux/Line input.
   - Very loud/distorted sound: Line Out setting into a Phono input.
5. The tracking force is set too heavy (stylus assembly is bottoming out on record). Set tracking force per cartridge manufacturer’s recommendation.
6. Turntable is picking up excessive vibrations from floor, walls, or nearby speakers. Reduce vibrations or place turntable on sturdy/solid surface.

Turntable operates but stylus “skips” across record.
1. The stylus guard is still in place. Remove the stylus guard.
2. The tracking force is set too light. Set tracking force per cartridge manufacturer’s recommendation.
3. The anti-skate control is set improperly. Verify anti-skate is set for same value as cartridge tracking force.

Record sounds too fast or too slow.
1. Turntable is set for wrong speed. Make proper speed selection for record type being played with platter speed selector.

Tips to avoid damage
- Do not touch the stylus tip with your fingers; avoid bumping the stylus on the turntable mat or a record’s edge.
- Clean the stylus tip frequently, using a soft brush and a back-to-front motion.
- If you use a stylus cleaning fluid, use it sparingly.
- Never apply harsh chemicals or solvents to any part of the turntable system.
- Prior to moving the turntable, always unplug it from the AC outlet and lock the tonearm on the tonearm rest.

Specifications*

<table>
<thead>
<tr>
<th>Specifications*</th>
</tr>
</thead>
<tbody>
<tr>
<td>Turntable Specifications</td>
</tr>
<tr>
<td>Type</td>
</tr>
<tr>
<td>Motor</td>
</tr>
<tr>
<td>Drive method</td>
</tr>
<tr>
<td>Speeds</td>
</tr>
<tr>
<td>Turntable platter</td>
</tr>
<tr>
<td>Starting torque</td>
</tr>
<tr>
<td>Braking system</td>
</tr>
<tr>
<td>Wow and flutter</td>
</tr>
<tr>
<td>Signal-to-noise ratio</td>
</tr>
<tr>
<td>Outputs levels</td>
</tr>
<tr>
<td>“PHONO” (Pre-amp bypassed)</td>
</tr>
<tr>
<td>“LINE” (Pre-amp engaged)</td>
</tr>
<tr>
<td>Phono Pre-amp gain</td>
</tr>
<tr>
<td>USB function</td>
</tr>
<tr>
<td>A,D</td>
</tr>
<tr>
<td>Computer interface</td>
</tr>
<tr>
<td>Tonearm Specifications</td>
</tr>
<tr>
<td>Type</td>
</tr>
<tr>
<td>Effective length</td>
</tr>
<tr>
<td>Overhang</td>
</tr>
<tr>
<td>Maximum tracking error angle</td>
</tr>
<tr>
<td>Stylus pressure adjustment range</td>
</tr>
<tr>
<td>Applicable cartridge weight range (including headshell)</td>
</tr>
<tr>
<td>Cartridge and Headshell Specifications</td>
</tr>
<tr>
<td>Cartridge Model</td>
</tr>
<tr>
<td>Cartridge Type</td>
</tr>
<tr>
<td>Recommended load impedance</td>
</tr>
<tr>
<td>Output voltage</td>
</tr>
<tr>
<td>Stylus</td>
</tr>
<tr>
<td>Tracking force range</td>
</tr>
<tr>
<td>Cartridge weight</td>
</tr>
<tr>
<td>Headshell model</td>
</tr>
<tr>
<td>Headshell weight</td>
</tr>
<tr>
<td>Headshell overhang adjustment</td>
</tr>
<tr>
<td>General Specifications</td>
</tr>
<tr>
<td>Power supply requirements</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Power consumption</td>
</tr>
<tr>
<td>Dimensions</td>
</tr>
<tr>
<td>Weight</td>
</tr>
<tr>
<td>Accessories included</td>
</tr>
<tr>
<td>Audacity :</td>
</tr>
<tr>
<td>System requirements</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Installation</td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>

*Specifications are subject to change without notice.
Visit our Web Site: www.audio-technica.com

One-Year Limited Warranty
Audio-Technica brand products purchased in the U.S.A. are warranted for one year from date of purchase by Audio-Technica U.S., Inc. (A.T.U.S.) to be free of defects in materials and workmanship. In event of such defect, product will be repaired promptly without charge or, at our option, replaced with a new product of equal or superior value if delivered to A.T.U.S. or an Authorized Service Center, prepaid, together with the sales slip or other proof of purchase date. Prior approval from A.T.U.S. is required for return. This warranty excludes defects due to normal wear, abuse, shipping damage, or failure to use product in accordance with instructions. This warranty is void in the event of unauthorized repair or modification, or removal or defacing of the product labeling.

For return approval and shipping information, contact the Service Dept., Audio-Technica U.S., Inc., 1221 Commerce Drive, Stow, Ohio 44224.

Except to the extent precluded by applicable state law, A.T.U.S. will have no liability for any consequential, incidental, or special damages; any warranty of merchantability or fitness for particular purpose expires when this warranty expires.

This warranty gives you specific legal rights, and you may have other rights which vary from state to state.

Outside the U.S.A., please contact your local dealer for warranty details.

Visitez notre site web : www.audio-technica.com

Garantie limitée de 1 an
Les produits de la marque Audio-Technica achetés aux États-Unis sont garantis pendant un an à compter de la date d'achat contre tout défaut de matériel et de fabrication par Audio-Technica U.S., Inc. (A.T.U.S.). Dans l’éventualité d’un tel défaut, le produit sera soit réparé gratuitement et dans les plus brefs délais, soit remplacé à notre convenance par un nouveau produit d’une valeur égale ou supérieure. Le produit doit être retourné en port payé à A.T.U.S. ou à un centre agréé de service après-vente avec un ticket de caisse ou autre preuve de la date d’achat. Le renvoi ne peut avoir lieu sans l’accord préalable de A.T.U.S. Cette garantie exclut les défauts liés à une usure normale, à un usage abusif, à tout incident survenu lors du transport ou à une utilisation non conforme au mode d’emploi. Cette garantie n’est pas valable en cas de réparation ou de modification effectuée par un personnel non agréé ou dans le cas où la marque du produit aurait été enlevée ou altérée.

Pour obtenir notre accord pour le retour et pour tout renseignement concernant le transport, veuillez prendre contact avec le département de service après-vente, Audio-Technica U.S., Inc., 1221 Commerce Drive, Stow, Ohio 44224.

A.T.U.S. ne sera pas tenu responsable des dommages indirects, accessoires ou spéciaux à moins que la loi applicable de l’État n’en dispose autrement ; lorsque cette garantie expire, toute garantie de valeur marchande ou d’aptitude à un usage particulier expire.

Cette garantie vous confère des droits spécifiques ; il se peut par ailleurs que vous ayez d’autres droits qui varient d’un État à l’autre.

En dehors des États-Unis, veuillez prendre contact avec votre revendeur local pour plus de détails concernant la garantie.

Visite nuestro sitio Web: www.audio-technica.com

Garantía limitada de un año
Audio-Technica U.S., Inc. (A.T.U.S.) ofrece una garantía de un año desde la fecha de compra en lo que se refiere a materiales y fabricación para todos los productos de la marca Audio-Technica adquiridos en Estados Unidos. En caso de que tenga algún defecto, el producto será reparado inmediatamente sin cargo alguno o, según nuestro criterio, reemplazado por uno nuevo de valor igual o superior, si se envía a A.T.U.S. o a un Centro de Servicio autorizado, franqueado y junto con el recibo de compra u otro comprobante de la fecha de compra. Toda devolución requiere la autorización previa de A.T.U.S. Esta garantía excluye defectos debidos al uso diario, al uso inapropiado, al transporte o a otros problemas que se produzcan por no utilizar el producto según las instrucciones. Esta garantía no será válida en caso de reparaciones o modificaciones no autorizadas o si se ha retirado la identificación del producto.

Para aprobación de devoluciones e información de envío, póngase en contacto con el Departamento de Servicio de Audio-Technica U.S., Inc., 1221 Commerce Drive, Stow, Ohio 44224 (EE. UU.).

En la medida en que lo permita la ley aplicable del estado, A.T.U.S. renuncia a toda responsabilidad por los daños especiales, incidentales, consecuentes o indirectos comoquiera que se produzcan a partir de este producto o la información, toda garantía de comerciabilidad e idoneidad para un fin determinado caduca al hacerlo esta garantía.

Esta garantía le otorga a usted derechos legales específicos y puede tener otros derechos que varíen de un estado a otro.

Fuera de Estados Unidos, póngase en contacto con su distribuidor local para conocer los detalles de la garantía.
Quick Start Guide

1. Check that the operating voltage is appropriate for your region: EU label indicates 220 - 240V and US label indicates 120V as affixed to rear of the turntable, before applying mains power. The voltage is factory-set for the region where this turntable is expected to be first sold and cannot be switched by the user.

2. Carefully insert the headshell/cartridge into the tonearm connector and tighten up the connector.

3. Install the counterweight by gently screwing it into the back of the tonearm.

4. Balance the tonearm and set the stylus pressure (tracking force):
   a. Remove the stylus protector, release the tonearm from its rest and rotate the counterweight until the tonearm becomes horizontally balanced.
   b. Place the tonearm back into the rest and engage the lock.
   c. Holding the counterweight steady, rotate the black stylus pressure ring (this turns independently of the counterweight) until the '0' lines up with the centre line of the rear of the tonearm. The '0' indicates the tonearm's 'balanced' position.
   d. Rotate the counterweight and stylus pressure ring counter clockwise and set to 2.0 grams. This is the appropriate setting for the included Audio-Technica AT95EX cartridge.

5. Set the Anti-Skate dial to 2.0

6. Place the turntable platter onto the centre spindle, ensuring it is fully seated on the spindle.

7. Place the included rubber mat onto the top of the platter.

8. Connect the turntable to either your amplifier, receiver, powered speakers or computer as described in the owner’s manual.

9. Attach the included power cord to the connector at the rear of the turntable, turn on the power switch located at the side of the power connector (ensuring the volume of your amplifier or speakers is set low) and select the appropriate speed for you record with the control knob on the top of the turntable.

Overhang Adjustment Guide

Use this guide when installing an alternative cartridge and/or headshell on your AT-LP5

1. Place this Adjustment Guide onto the centre spindle of the platter.

2. Locate the blue dot between the A lines and B lines, carefully place the cartridge needle on the blue dot.

3. Carefully adjust the position of the cartridge within the headshell until the cartridge sides are parallel with the headshell sides.

4. Carefully move the cartridge forwards or backwards (overhang adjustment) within the headshell so that the cartridge sides remain parallel with the A lines, while the cartridge front becomes parallel with the B lines, as shown in the "OK - Perfect Overhang Setting" diagram.

5. Next carefully place the cartridge needle on the blue dot between the B lines and C lines. The sides of the cartridge should now be parallel to the C lines, with the cartridge front still parallel to the B lines, as shown in the "OK - Perfect Overhang Setting" diagram.

6. If this is not the case, continue the overhang adjustment procedure by returning to step 4. and continue to move the cartridge needle between the two blue dots until the overhang is consistent when placed on either one.
AUDACITY QUICK GUIDE (PC editing program)

Before Starting the Software
Make sure that your USB turntable is plugged into the computer and both the computer and the turntable are plugged in and switched on.

To Install Software (PC)
1. Plug in your turntable to an AC outlet and connect the USB port on the Turntable to the USB port of your computer.
2. Turn on the power switch to your turntable.
3. Windows system will detects a new device and that it is available to use.
4. Insert the CD that came with your USB turntable.
5. Run the file “install audacity-win-1.2.4b.exe” to install Audacity software. Once installed, run the Audacity program.

To Install Software (MAC)
1. Insert the included CD
2. Open the CD icon on the desktop.
3. Drag the installation folder for audacity to your hard drive. We recommend that you move the folder to your “Applications” folder.
4. A window will come up which shows the files copying.
5. EJECT the CD.
6. Open “Audacity” from where you moved it to on your hard drive.

Software Configuration
1. Click on Microphone in the drop down menu and select “Stereo Mix”

![Figure 1: Select Stereo Mix](image)

2. Select the “Edit” menu and then “Preferences”
Select the USB audio device under the “Recording” selection as shown. Select “Software Playthrough” to hear the audio while recording.

*Note: The USB Turntable may show up with a different name in Windows system. This may depend on your computer model and operating system. 99% of the time it will contain “USB” in the Name.*

![Audacity Preferences](image)

*Figure 2: Select USB Audio Device from Preferences*

After completed the above settings, you are ready for recording.

If you are still having difficulties finding the USB Turntable, try to check your system settings or control panel to adjust audio input settings from the sound control panel.

*Note:*
The attached Audacity software is for reference only. Please download the latest version from the following website: [http://www.audacityteam.org/](http://www.audacityteam.org/)
Please check the following website and download the trial software for more sound editing software: [http://www.bias-inc.com](http://www.bias-inc.com)
Toolbars

Selection tool - for selecting the range of audio you want to edit or listen to.

Envelope tool - for changing the volume over time.

Draw tool - for modifying individual samples.

Zoom tool - for zooming in and out.

Time shift tool - for sliding tracks left or right.

Multi tool - lets you access all of these tools at once depending on the location of the mouse and the keys you are holding down.

Audio Control Buttons

Skip to Start - moves the cursor to time 0. If you press Play at this point, your project will play from the beginning.

Play - starts playing audio at the cursor position. If some audio is selected, only the selection is played.

Loop - if you hold down the Shift key, the Play button changes to a Loop button, which lets you keep playing the selection over and over again.

Record - starts recording audio at the project sample rate (the sample rate in the lower-left corner of the window). The new track will begin at the current cursor position, so click the "Skip to Start" button first if you want the track to begin at time 0.

Pause - temporarily stops playback or recording until you press pause again.

Stop - stops recording or playing. You must do this before applying effects, saving or exporting.
Skip to End - moves the cursor to the end of the last track.

**Edit Toolbar**

All of the buttons on this toolbar perform actions - and with a couple of exceptions, they're all just shortcuts of existing menu items to save you time. Holding the mouse over a tool will show a "tooltip" in case you forget which one is which.

- Cut
- Copy
- Paste
- Trim away the audio outside the selection
- Silence the selected audio
- Undo
- Redo (repeat last command).
- Zoom In
- Zoom Out
- Fit selection in window - zooms until the selection just fits inside the window.
- Fit project in window - zooms until all of the audio just fits inside the window.
Track Pop-Down Menu

The Track Pop-Down Menu appears when you click in a track's title. This lets you access a few special commands that apply to individual tracks.

**Name...** - lets you change the name of the track.

**Move Track Up** - exchange places with the track above this one.

**Move Track Down** - exchange places with the track below this one.

**Waveform** - sets the display to Waveform - this is the default way of visualizing audio.

**Waveform (dB)** - similar to Waveform, but on a logarithmic scale, measured in decibels (dB).

**Spectrum** - display the track as a spectrogram, showing the amount of energy in different frequency bands.

**Pitch (EAC)** - highlights the contour of the fundamental frequency (musical pitch) of the audio, using the Enhanced Autocorrelation (EAC) algorithm.

**Mono** - makes this track a mono track, meaning it is played out of just one speaker, or played out of the left and right speakers equally.

**Left Channel** - makes this track come out of only the left speaker.

**Right Channel** - makes this track come out of only the right speaker.

**Make Stereo Track** - if there is another track below this one, joins them to make a single stereo track, with the top track representing the left speaker, and the bottom track representing the right speaker. When tracks are joined into a stereo pair, all edits automatically apply to both the left and right channel.
Split Stereo Track - if the selected track is a stereo track (a pair of left and right tracks joined together as a single track), this operation splits them into two separate tracks that you can modify and edit independently.

Set Sample Format - this determines the quality of the audio data and the amount of space it takes up. 16-bit is the quality used by audio CD’s and is the minimum quality that Audacity uses internally (8-bit audio files are automatically converted when you open them). 24-bit is used in higher-end audio hardware. 32-bit float is the highest quality that Audacity supports, and it is recommended that you use 32-bit float unless you have a slow computer or are running out of disk space.

Set Rate - sets the number of samples per second of the track. 44100 Hz is used by audio CDs. Tracks can have different sample rates in Audacity; they are automatically resampled to the project sample rate (in the lower-left corner of the window).

File Menu

New - creates a new empty window

Open... - opens an audio file or an Audacity project in a new window (unless the current window is empty). To add audio files to an existing project window, use one of the Import commands in the Project menu.

Close - closes the current window, asking you if you want to save changes. On Windows and Unix, closing the last window will quit Audacity, unless you modify this behavior in the Interface Preferences.

Save Project - saves everything in the window into an Audacity-specific format so that you can save and quickly continue your work later. An Audacity project consists of a project file, ending in ".aup", and a project data folder, ending in ".data". For example, if you name your project "Composition", then Audacity will create a file called "Composition.aup" and a folder called Composition_data. Audacity project files are not meant to be shared with other programs - use one of the Export commands (below) when you are finished editing a file.

Save Project As... - same as Save Project (above), but lets you save a project as a new name.

Recent Files ... - brings up a list of files you have recently opened in audacity to be re-opened quickly.
**Export As WAV...** - exports all of the audio in your project as a WAV file, an industry-standard format for uncompressed audio. You can change the standard file format used for exporting from Audacity by opening the File Format Preferences. Note that exporting will automatically mix and resample if you have more than one track, or varying sample rates. See also File Formats.

**Export Selection As WAV...** - same as above, but only exports the current selection.

**Export as MP3...** - exports all of the audio as an MP3 file. MP3 files are compressed and therefore take up much less disk space, but they lose some audio quality. Another compressed alternative is Ogg Vorbis (below). You can set the quality of MP3 compression in the File Format Preferences. See also MP3 Exporting.

**Export Selection As MP3...** - same as above, but only exports the current selection.

**Export as Ogg Vorbis...** - exports all of the audio as an Ogg Vorbis file. Ogg Vorbis files are compressed and therefore take up much less disk space, but they lose some audio quality. Ogg Vorbis files tend to take up a little less disk space than MP3 for similar compression quality, and Ogg Vorbis is free from patents and licensing restrictions, but Ogg Vorbis files are not as widespread. You can set the quality of Ogg compression in the File Format Preferences.

**Export Selection As Ogg Vorbis...** - same as above, but only exports the current selection.

**Export Labels...** - if you have a Label Track in your project, this lets you export the labels as a text file. You can import labels in the same text format using the "Import Labels..." command in the Project Menu.

**Export Multiple...** - lets you split your project into multiple files all in one step. You can either split them vertically (one new file per track), or horizontally (using labels in a Label Track to indicate the breaks between exported files).

**Page Setup** - configure how Audacity will print out the track waveforms using the Print option, and what printer to use.
Print - Print out the main window view from Audacity showing the tracks and waveforms.

Exit (Quit) - closes all windows and exits Audacity, prompting you to save any unsaved changes first.

Edit Menu

Undo - This will undo the last editing operation you performed to your project. Audacity supports full unlimited undo - meaning you can undo every editing operation back to when you opened the window.

Redo - This will redo any editing operations that were just undone. After you perform a new editing operation, you can no longer redo the operations that were undone.

Cut - Removes the selected audio data and places it on the clipboard. Only one "thing" can be on the clipboard at a time, but it may contain multiple tracks.

Copy - Copies the selected audio data to the clipboard without removing it from the project.

Paste - Inserts whatever is on the clipboard at the position of the selection or cursor in the project, replacing whatever audio data is currently selected, if any.

Trim - Removes everything to the left and right of the selection.

Delete - Removes the audio data that is currently selected without copying it to the clipboard.

Silence - Erases the audio data currently selected, replacing it with silence instead of removing it.

Split - Moves the selected region into its own track or tracks, replacing the affected portion of the original track with silence. See the figure below:
Duplicate - Makes a copy of all or a part of a track or set of tracks into new tracks. See the figure below:

Select ... > All - Selects all of the audio in all of the tracks in the project.

Select ... > Start to Cursor - Selects from the beginning of the selected tracks to the cursor position.

Select ... > Cursor to End - Selects from the cursor position to the end of the selected tracks.

Find Zero Crossings - Modifies the selection slightly so that both the left and right edge of the selection appear on a positive-slope zero crossing. This makes it easier to cut and paste audio without resulting in an audible clicking sound.

Selection Save - Remembers the current selection (or cursor position), allowing you to restore it later.

Selection Restore - Restores the cursor position to the last position saved by "Selection Save".

Move Cursor ... > to Track Start - Moves the cursor to the start of the current track.

Move Cursor ... > to Track End - Move the cursor to the end of the currently selected track.

Move Cursor ... > to Selection Start - Moves the cursor to the start of the current selection.

Move Cursor ... > to Selection End - Moves the cursor to the end of the current selection.

Snap-To ... > Snap On - Enable Snap-To mode. When Snap-To mode is enabled, the selection will be constrained to the nearest interval on the time scale, by default the nearest second. So if you click and drag from 4.2 seconds to 9.8 seconds, it will result in a selection from 4 seconds to 10
seconds, exactly. You can change the units that are snapped to using the "Set Selection Format" option in the View Menu.

**Snap-To ... > Snap Off** - Turns Snap-To mode off letting you select arbitrary ranges of time

**Preferences...** - Opens the preferences dialog.

**View Menu**

**Zoom In** - Zooms in on the horizontal axis of the audio, displaying more detail about less time. You can also use the zoom tool to zoom in on a particular part of the window.

**Zoom Normal** - Zooms to the default view, which displays about one inch per second.

**Zoom Out** - Zooms out, displaying less detail about more time.

**Fit in Window** - Zooms out until the entire project just fits in the window.

**Fit Vertically** - Resizes all of the tracks vertically so they all fit inside of the window (if possible).

**Zoom to Selection** - Zooms in or out so that the selection fills the window.

**Set Selection Format** - lets you choose the formatting that is displayed at the bottom of the window indicating the current selection time. Options include film, video, and audio CD frames, seconds + samples, or pure time. If you turn on Snap-To mode in the Edit Menu, the selection will snap to the frames or other quantization you have selected in this menu.

**History...** - Brings up the history window. It shows all the actions you have performed during the current session, including importing. The right-hand column shows the amount of hard disk space your operations used. You can jump back and forth between editing steps quite easily by simply clicking on the entries in the window, the same as selecting Undo or Redo many times in a row. You can also discard Undo history to save disk space. The history window can be kept open while you work.

**Float Control Toolbar** - moves the Control Toolbar out of the window and into its own floating window, so you can position it wherever you want. The
menu item changes to **Dock Control Toolbar**, which you can use to put the toolbar back into the main window.

**Float Edit Toolbar** - moves the Edit Toolbar out of the window and into its own floating window, so you can position it wherever you want. The menu item changes to **Dock Edit Toolbar**, which you can use to put the toolbar back into the main window.

**Float Meter Toolbar** - does the same thing for Audacity's VU meters which you use to set recording levels and adjust playback.

**Float Mixer Toolbar** - moves the Mixer Toolbar out of the window and into its own floating window as above.

**Project Menu**

**Import Audio...** - This command is used to import audio from a standard audio format into your project. Use this command if you already have a couple of tracks and you want to add another track to the same project, maybe to mix them together. You cannot use this option to import Audacity Projects. The only way to combine two Audacity Projects is to open them in separate windows, then copy and paste the tracks.

**Import Labels...** - This command takes a text file which contains time codes and labels, and turns them into a Label Track.

**Import MIDI...** - This menu command imports MIDI files and puts them into a MIDI Track. Audacity can display MIDI files, but *cannot play, edit, or save them yet.*

**Import Raw Data...** - This menu command allows you to open a file in virtually any uncompressed format. When you select the file, Audacity will analyze it and try to guess its format. It will guess correctly about 90% of the time, so you can try just pressing "OK" and listen to the result. If it is not correct, however, you can use the options in the dialog to try some other possible encodings.

At the beginning of your imported track(s), you may notice a little bit of noise. This is probably the file's header, which Audacity was not able to parse. Just zoom in and select the noise with the Selection Tool, and then choose Delete from the Edit Menu.

**Edit ID3 Tags...** - Opens a dialog allowing you to edit the ID3 tags associated with a project, for MP3 exporting.
Quick Mix - This command mixes all of the selected tracks together. If you are mixing stereo tracks, or mixing tracks that are marked as Left or Right channel, the result will be a stereo track (two channels), otherwise the result will be mono.

Your tracks are implicitly mixed whenever you hit the Play button and whenever you export. This command offers a way to do it permanently and save the results to disk, saving on playback resources.

Note that if you try to mix two very loud tracks together, you may get clipping (it will sound like pops, clicks, and noise). To avoid this, drag the gain slider on the tracks down to reduce their volume before mixing.

New Audio Track - This creates a new empty Audio Track. This command is rarely needed, since importing, recording, and mixing automatically create new tracks as needed. But you can use this to cut or copy data from an existing track and paste it into a blank track. If that track was at a non-default rate then you may need to use Set Rate from the Track Pop-Down menu to set the correct sample rate.

New Stereo Track - same as above, but creates a stereo track. You can also create a stereo track by joining two tracks using the track pop-down menu.

New Label Track - This creates a new Label Track, which can be very useful for textual annotation.

New Time Track - This creates a new Time Track, which is used to vary the speed of playback over time.

Remove Tracks - This command removes the selected track or tracks from the project. Even if only part of a track is selected, the entire track is removed. You can also delete a track by clicking the X in its upper-left corner. To cut out only part of the audio in a track, use Delete or Silence.

Align Tracks... - All the Align functions work on whole tracks or groups of tracks, not on selections, even if they span across multiple tracks. They all operate by time-shifting tracks (moving them left or right), making it easier to synchronize tracks or get rid of silence at the beginning. The cursor or selection stays in the same place unless you use "Align and move cursor...", below:

Align and move cursor... - same as the functions above, except that the cursor or selection is moved along with the tracks. That allows you to shift the tracks without losing your relative place.
**Add Label at Selection** - This menu item lets you create a new label at the current selection. You can title the label by typing with the keyboard and then hitting "Enter" when you're done.

**Add Label at Playback Position** - This menu item lets you create a new label at the current location where you are playing or recording. Do this if you want to mark a certain passage while you're listening to it. You can title the label by typing with the keyboard and then hitting "Enter" or "Return" when you're done. Only available whilst audacity is playing.

**Generate Menu**

If you choose an item from the Generate menu when there are no tracks in a project, a new track is created. Otherwise, the current track is used. If a track is selected and the cursor is placed in a single place in the track audio is inserted at the cursor position. The default duration is 30 seconds. The audio created will replace the any selection, otherwise it is inserted into the track, shifting up later parts of the track.

**Silence** - Inserts silence

**Tone...** - You can create a Sine wave, Square wave, or Sawtooth wave.

**White Noise** - Inserts random audio samples, which sounds like pure static.

Any items which appear after these three built-ins are VST, Ladspa, or Nyquist plug-ins. It is possible for a poorly written plug-in to crash Audacity, so always save your work before using a plug-in. Note that any effect that doesn't take any audio as input will automatically be placed in the Generate menu.

**Effect Menu**

The items in this menu only work when you have audio selected. Audacity does not have any real-time effects, you must select the audio, apply the effect, and then listen to the results. Most effects have a Preview button. Clicking on this button plays up to three seconds of audio, allowing you to hear what it will sound like after the effect is applied. This is useful for fine-tuning the effect parameters.
Repeat Last Effect - Selecting this command is a shortcut to applying the most recent effect with the same settings. This is a convenient way to quickly apply the same effect to many different parts of a file.

Amplify - Changes the volume of the selected audio. If you click the "Allow clipping" checkbox, it will let you amplify so much that the audio ends up beyond the range of the waveform, and is clipped (distorted). The default value when you open the effect is to amplify so that the loudest part of the selection is as loud as possible without distortion.

Bass Boost - Enhances the bass frequencies in the audio.

Change Pitch - Changes the pitch/frequency of the selected audio without changing the tempo. When you open the dialog, the starting frequency is set to Audacity’s best guess as to the frequency of the selection. This works well for recordings of singing or musical instruments without background noise. You can specify the pitch change in one of four different ways: musical note, semitones, frequency, or percent change.

Change Speed - Changes the speed of the audio by resampling. Making the speed higher will also increase the pitch, and vice versa. This will change the length of the selection.

Change Tempo - Changes the tempo (speed) of the audio without changing the pitch. This will change the length of the selection.

Compressor - Compresses the dynamic range of the selection so that the loud parts are softer while keeping the volume of the soft parts the same. You can optionally normalize the recording afterwards, resulting in the entire piece having higher perceived volume.

Echo - Very simple effect that repeats the selection with a decay, sounding like a series of echos. This effect does not change the length of the selection, so you may want to add silence to the end of the track before applying it (using the Generate Menu).

Equalization - Boost or reduce arbitrary frequencies. You can select one of a number of different curves designed to equalize the sound of some popular record manufacturers, or draw your own curve.

Fade In - Fades the selection in linearly.

Fade Out - Fades the selection out linearly
**FFT Filter** - Similar to Equalization, lets you enhance or reduce arbitrary frequencies. The curve here uses a linear scale for frequency.

**Invert** - Flips the waveform vertically, the same as a phase inversion in the analogue domain.

**Noise Removal** - This effect lets you clean up noise from a recording. First, select a small piece of audio that is silent except for the noise, select "Noise Removal", and click on the "Get Noise Profile" button. Then select all of the audio you want filtered select "Noise Removal" again, and click the "Remove Noise" button. You can experiment with the slider to try to remove more or less noise. It is normal for Noise Removal to result in some distortion. It works best when the audio signal is much louder than the noise.

**Normalize** - Allows you to correct for DC offset (a vertical displacement of the track) and/or amplify such that the maximum amplitude is a fixed amount, -3 dB. It's useful to normalize all of your tracks before mixing. If you have a lot of tracks, you may then need to use the track gain sliders to turn some down.

**Nyquist Prompt** - For advanced users only. Allows you to express arbitrary transformations using a powerful functional programming language. See the Nyquist section of the Audacity website for more information.

**Phaser** - The name "Phaser" comes from "Phase Shifter", because it works by combining phase-shifted signals with the original signal. The movement of the phase-shifted signals is controlled using a Low Frequency Oscillator (LFO).

**Repeat** - Repeats the selection a certain number of times. This operation is quite fast and space-efficient, so it is practical to use it to create nearly-infinite loops.

**Reverse** - This effect reverses the selected audio temporally; after the effect the end of the audio will be heard first and the beginning last.

**Wahwah** - Uses a moving bandpass filter to create its sound. A low frequency oscillator (LFO) is used to control the movement of the filter throughout the frequency spectrum. Adjusts the phase of the left and right channels when given a stereo selection, so that the effect seems to travel across the speakers.
Plugins 1 to 15 ... etc. These submenus contain any VST, Ladspa, or Nyquist plug-ins loaded by Audacity. It is possible for a poorly written plug-in to crash Audacity, so always save your work before using a plug-in effect.

Analyze Menu

Plot Spectrum - To use this feature, first select a region of audio from a single track, then select "Plot Spectrum". It opens up a window that displays the Power Spectrum of the audio over that region, calculated using the Fast Fourier Transform. The graph represents how much energy is in each frequency. As you move the mouse over the display, it shows you the nearest peak frequency. This window can also display other common functions that are calculated using the Fast Fourier Transform, including three versions of the Autocorrelation function. The Enhanced Autocorrelation function is very good at identifying the pitch of a note.

The Analyze menu is intended for effects and plug-in effects that do not modify the audio, but simply open a dialog with some descriptive information. Audacity also supports Analyze commands that create annotations in a Label Track.

Help Menu

About Audacity - displays the version number and credits. If you compiled Audacity yourself, check here to verify which optional modules were successfully compiled in.